
Formation QGIS 3.44

Journée 3 – Symbologie & Jointure tableur



Journée 3
• Symbologie

• Joindre un tableur Excel
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Représenter
Style 

Symbole
Gérer

Ressources

• Représenter la donnée
• Style
• Symboles

– Couche de symboles
– Ponctuels
– Linéaires
– Surfaces
– Polygone inversé
– Grappes de points
– Etiquettes

• Gérer
• Ressources
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Représenter la donnée

Nombreuses manières de représenter la donnée, et 
qui peuvent se combiner

• En fonction de l’échelle → lisibilité est recherchée

• En fonction d’attributs → cartes thématiques

• En fonction du public visé → grand public <> spécialistes

• En fonction du média de communication → écrans, sortie 
papier (A4 → A0), fichier PDF
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Style

STYLE : plus haut niveau d’organisation de la 
représentation → éléments suivants :

• Symboles → représentation graphique

• Etiquettes → texte graphique sur la carte

• Info-bulles → au survol de la souris

• Présentation des attributs

• Etc.
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Style

Outils pour sauver, exporter, importer les styles 
associés aux couches

• Donner des noms significatifs aux styles, plus facile pour les 
gérer

• Fichiers *.qml

• Entrepôt de styles → localisation à définir via menu 
Préférences → Options → Sources de données → 
« Chemins de données localisés » (redémarrer QGIS)
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• Options de création – personnalisation - d’un 
symbole sont … très nombreuses

• Impossible d’aborder toutes les combinaisons

• Usage et la créativité personnelle → définir un 
catalogue efficace de symboles …

• S’inspirer des éditeurs cartographiques 
professionnels : les légendes des cartes IGN, Michelin 
… sont généralement très efficaces.

Editeur de Symboles



Editeur de Symboles
• Très puissant et offre différents niveaux de 

représentation des entités (objets).

• Un symbole peut être composé d’une ou de 
plusieurs représentations (empilement de couches 
de représentation)

• L’éditeur de symboles propose un maximum 
d’interfaces communes pour tous les types (Point, 
Ligne, Surface) mais d’autres sont spécifiques à la 
nature géométrique de l’objet.

• Modes simple et avancé de représentation sont 
proposés
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Editeur de Symboles

• Le niveau supérieur de définition du symbole 
dépend de la géométrie de la couche de données

• Marqueur (données Ponctuelles), Ligne (données 
Linéaires) ou Remplissage (données Surfaciques)

• Ensuite, chaque symbole peut incorporer un ou 
plusieurs symboles (y compris, de tout autre type) 
: c'est la couche de symboles (ou symbole à 
représentations multiples).
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Symboles

Deux accès (pour une couche vectorielle)

• Propriétés de la couche → Symbologie / Etiquettes

• Par un double-clic bouton gauche de la souris, sur la 
représentation de la couche

Formation QGIS – © JM Michalowski  - IFAPME 2026 10



Symboles
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1 - Mode de rendu du 
symbole
2 - Personnalisation d’un 
symbole
3 - Unité et Opacité de la 
représentation (inverse 
transparence)
4 - Palette de couleurs
5 - Catalogue de symboles 
prédéfinis
6 - Accès au gestionnaire de 
styles
7 - Représentation des 
symboles d’un groupe
8 - Rendu de la couche
9 - Gestion du style courant
10 - Sauver le symbole 
courant
11 - Edition avancée – non 
documenté



Symboles
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• Un symbole peut être composé de plusieurs couches de 
symboles

• Un symbole est constitué d’au moins une couche de symbole

• L’arborescence des symboles montre la superposition (et 
l’ordre d’empilement) de ces couches de symboles qui sont 
ensuite combinées pour former un nouveau symbole global.

 Rendu : symbole unique

 Type : ligne

 Composé de 3 couches 



Modes de rendu du symbole
Le mode de rendu donne accès aux différents modes 
d’affichage des entités, le plus simple étant le « Symbole 
unique ». 
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Pas de symbologie

Unique : symbole pour rendre de manière identique toutes les entités de la couche

Catégorisé : symboles dont l’aspect reflète des valeurs discrètes (chaine de caractères)

Gradué : symboles dont l’aspect reflète des classes de valeurs (dates, valeurs numériques)

Ensemble de règles : symboles associant des combinaisons d’attributs

Entités fusionnées : symboles lignes/surfaces assurant une représentation continue 

Polygones inversés : symbole à appliquer à l’extérieur des polygones de la couche.

2,5 D : pseudo 3D

Symboles intégrés : symbologie “native” (KML ou TAB)

Spécifique
Points



Unités du symbole
• Unités : unités d’affichage des symboles : mm (par 

défaut), points, pixels, mètres à l’échelle, unités de 
cartes pouces. 

• Millimètres et Unités de cartes sont les plus utiles.
– Millimètre : La valeur millimétrique indiquée reste 

constante, quelle que soit l'échelle de la zone 
d'affichage cartographique de QGIS

– Unités de carte : La taille du symbole varie en fonction 
de l’échelle : il paraît de moins en moins large plus 
l'échelle devient petite. L’unité est le « mètre terrain » si 
l’unité de mesures du terrain est le mètre (Propriétés du 
projet → Onglet Général → Mesures).
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Sélection de couleurs

Outil (« widget ») commun : sélection de couleurs 
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« Clic Gauche »

« Clic Droit »



Catalogue de symboles QGIS
• QGIS propose un catalogue de symboles prédéfinis pour 

tous les types de géométrie, ainsi que des palettes de 
couleur.

• Ce catalogue peut être consulté depuis le Gestionnaire de 
Style
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Rendu de la couche
• Opacité : définir le niveau d’opacité de toute la couche de 

symboles. 
– entièrement opaque : valeur 100

– entièrement transparente : valeur zéro.

• Mode de fusion : définir la manière dont une couche va 
s'intégrer dans celle située en-dessous pour le mode de 
fusion entre couche, ou entre objets de la couche pour le 
mode de fusion entre objets.
– Fusionner, assombrir, éclaircir …

– Fonctionnalité développée pour les graphistes

– Cartographie : à utiliser avec modération (impressions !!)
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Paramètres généraux POINTS
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Type de symbole : voir catalogue
Taille: une valeur définie (+ choix de 
l’unité)
Couleur de remplissage : palette
Opacité : de 100 % à 0 %
Rotation : à définir si nécessaire
Choix du symbole : catalogue de 
symboles par défaut (cas du type « 
Symbole simple »)

Quand le symbole ne 
comporte qu’une couche, ce 
sont les paramètres généraux 
qui s’appliquent



Paramètres généraux LIGNES
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Type de symbole : voir catalogue
Largeur : une valeur définie (+ choix de 
l’unité)
Couleur de remplissage : palette
Opacité : de 100 % à 0 %
Choix du symbole : catalogue de 
symboles par défaut (cas du type « 
Symbole simple »)

Quand le symbole ne 
comporte qu’une couche, ce 
sont les paramètres généraux 
qui s’appliquent



Paramètres généraux SURFACES
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Type de symbole : voir catalogue
Couleur de remplissage : palette
Opacité : de 100 % à 0 %
Choix du symbole : catalogue de 
symboles par défaut (cas du type « 
Symbole simple »)

Quand le symbole ne 
comporte qu’une couche, ce 
sont les paramètres généraux 
qui s’appliquent



Symbole SVG
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Les images SVG (Scalable Vector 
Graphics) peuvent être agrandies 
à l’infini sans perte de qualité.

Bibliothèque personnelle de SVG



• Symboles vectoriel SVG
– Votre moteur de recherche favori

– Viewer SVG : 
• Smart SVG Viewer https://sla80.github.io/SmartSvgViewer/ 

• Microsoft Hegde (IE)

• XnView (https://www.xnview.com/fr/ ) : visionneuse 
multimédia efficace, un explorateur et convertisseur. 

– Bibliothèques
• https://www.flaticon.com/ (18.0M+ icones SVG)

• Bibliothèque SVG du projet OSM 
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Symbole SVG

https://sla80.github.io/SmartSvgViewer/
https://www.xnview.com/fr/
https://www.flaticon.com/
https://www.flaticon.com/
https://github.com/openstreetmap/map-icons/tree/master
https://github.com/openstreetmap/map-icons/tree/master


Symbole SVG
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Répertoire personnalisé

Répertoire personnalisé

Accès à la bibliothèque SVG : 
menu Préférences → Options → Système → SVG Paths



Ordre de tracé des couches de symboles

• L’ordre de tracé des couches de symboles est le suivant : la 
première couche est dessinée au-dessus, tandis que la 
dernière est tracée tout en-dessous.

• Des boutons permettent la navigation parmi les couches. 

• Le verrouillage de la couleur d’une couche empêche la 
modification de sa couleur lors d’un changement de la 
couleur du niveau supérieur du symbole.
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Ordre de tracé des couches de symbole

• La largeur du symbole est définie par la largeur (du niveau 
supérieur) du symbole.

• Mais si la largeur d’une couche est supérieure à celle-ci, la 
largeur du niveau supérieur s’adapte pour la prendre en 
compte.

• Les largeurs des autres couches sont ensuite recalculées en 
proportion du changement de la largeur du (niveau 
supérieur) du symbole.
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Gestionnaire de styles

Organisation des Styles
1. Créer, modifier, et supprimer des styles pour vos couches 

de données.

2. Organiser vos styles en différentes catégories et sous-
catégories pour une meilleure gestion.

Création et Modification des Symboles
1. Créer de nouveaux symboles ou modifier les symboles 

existants

2. Large variété d'options pour personnaliser les symboles
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Gestionnaire de styles

Deux options principales pour gérer la localisation des styles
– Défaut : accessibles dans tous vos projets QGIS (cohérence styles 

à travers tous les projets)

– Projet : spécifiques au projet sur lequel vous travaillez.

Avantages et Inconvénients
– Défaut:

• Avantage : Réutilisation facile des styles.

• Inconvénient : Peut devenir encombrant si trop de styles sont enregistrés.

– Projet:
• Avantage : Organisation claire et spécifique au projet.

• Inconvénient : Les styles doivent être recréés pour chaque nouveau projet.
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



Gestionnaire de styles
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Gestionnaire de styles

Marque-pages :
• Enregistrement et accès rapide aux styles fréquemment utilisés.

• Facilite la standardisation et améliore la gestion des symboles.

Toutes : affichage de toutes les étiquettes (Défaut + Projet)

Etiquettes : liste des mots-clés 

Groupes intelligents : 
• Organisation automatique des symboles en fonction de critères définis.

• Simplifie la gestion des symboles (?).

Ajouter un mot-clé Un style peut être balisé avec plusieurs mots-clés différents (,)

Ajouter un groupe intelligent → définir les critères de tri

Modifier le groupe : associer un mot-clé à un groupe de symboles

Importer / exporter des styles depuis/vers fichier .XML
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EXERCICE 1 

Le Gestionnaire de 
Styles 

• Copier des styles « Projet » 
vers « Défaut »

• Comparer styles « Projet » et 
styles « Défaut »
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Gestionnaire de styles
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Nouveau projet

Si des symboles sont présents pour, 
cette étiquette, les sélectionner (CTRL-A)

 et les supprimer 

« Nettoyage »



Gestionnaire de styles
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Import .XML vers « Style de projet » Les styles dans "Style de projet" sont 
stockés dans le fichier de projet lui-même.



Gestionnaire de styles
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Gestionnaire de styles
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Sélectionner RX – Douglas
et RX – Mélèze



Gestionnaire de styles
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« Défaut » : pour tous les projets



Gestionnaire de styles

Style « Par Projet »

•  Portable : si vous partagez 
le fichier projet, les styles 
suivent

•  Isolé : ne pollue pas votre 
bibliothèque de styles globale

•  Spécifique au projet : 
idéal pour des styles 
thématiques

•  Non réutilisable ailleurs : 
disponible uniquement dans 
CE projet
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Style « Défaut »

•  Global : disponible dans
TOUS  vos projets QGIS 
•  Persistant : reste après
fermeture de QGIS 
•  Réutilisable : parfait pour des
styles standards que vous utilisez
souvent 
•  Lié à votre machine/profil : 
ne voyage pas avec le projet 
•  Non partagé : vos collègues
ne l'ont pas automatiquement 



Gestionnaire de styles
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EXERCICE 2

Polygones : 

• Rendu catégorie

• Centroïdes SVG

• Fond raster
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Polygones : rendu catégorisé

Ouvrir le projet ../Cartographie/Jour3/Data/Jour3-01.qgz

Couche « Corine Land Cover »
1. Couche > Propriétés > Symbologie > [Style]

2. Charger le style « CLC_2018_FR.qml »
sous ..\Cartographie\Symbologie\Styles 
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Polygones : rendu catégorisé
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Polygones : rendu catégorisé
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Symbole SVG
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Répertoire personnalisé

Répertoire personnalisé en fonction de votre installation

Accès à la bibliothèque SVG : 
menu Préférences → Options → Système → SVG Paths



Polygones : rendu catégorisé

1. Modifier symbole « Zones industrielles et commerciales » (121)

2. Remplissage de fond + remplissage centroïde avec SVG
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Polygones : rendu catégorisé

3. Ajouter « Remplissage de centroïde » puis choisir le SVG

4. Paramétrer l’affichage du SVG
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../Cartographie/Symbologie/SVG/EquipementsPublics/00_industrie.svg



Polygones : rendu catégorisé

5. Changer la couleur du symbole de remplissage

6. Sauver le symbole
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Polygones : rendu catégorisé
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Polygones : rendu catégorisé

1. Modifier le symbole « Forêts de feuillus »

2. Remplissage de fond avec une image PNG (gère la transparence)
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../Jour3/Symbologie/Raster/Landuse-forest.png



Polygones : rendu catégorisé
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EXERCICE 3
Polygones : 

• Rendu catégorisé
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Polygones : rendu catégorisé

• Couche Espaces Verts Liège
– Accéder au symbole et le modifier pour arriver à 

– [Appliquer]  > [OK]

Formation QGIS – © JM Michalowski  - IFAPME 2026 50



Polygones : rendu catégorisé

• Couche Espaces Verts Liège
– Revenir au symbole pour définir un rendu catégorisé

– L’attribut LANDUSE (OSM) de la couche Espaces Verts permet de 
décrire le type d’espace vert. 
• Cemetery [cimetière]

• Park [parc]

• Farmyard [(cour de) ferme]

• Greenhouse_horticulture [horticulture]

• Farmland [agriculture]

• Grassland  [prairie]

– Type de rendu : choisir Catégorisé
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Polygones : rendu catégorisé

• Valeur : Landuse

• Symbole : garder symbole courant

• Palette de couleurs : Greens

• Bouton [Classer]

• Editer la légende (double clic) et décrire les différents types

• [Delete Unused] et [Appliquer]
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Polygones : rendu catégorisé
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Décocher une des classes et constater dans la carte que les 
objets qui correspondent à cette classe, sont masqués



EXERCICE 4

Polygones : 

• Rendu gradué

• Function 
round($area,1)
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Polygones : rendu gradué

• Couche Espaces Verts
– Revenir au symbole pour définir un rendu gradué

– Type de rendu : choisir Gradué

– Valeur : clic sur         > Ouvre le calculateur d’expressions

– Géométrie
• Attributs géométriques des

entités

• $area : superficie

• Valider [OK]
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Polygones : rendu gradué

Les options les plus intéressantes
• Les modes de classement (les plus utiles) et l’histogramme 

correspondant
– Intervalle égal : pour toutes les classes, la différence entre la valeur 

minimale et la maximale est constante
– Jolies ruptures : pour toutes les classes, la différence entre la valeur 

minimale et la maximale est constante et les limites de classes sont 
arrondies (aux dizaines par exemple)

– Nombre égal : les intervalles de classes sont calculés afin de répartir les 
objets de façon équitable entre les différentes classes.

• Le nombre de classes pour caractériser la plage de valeurs
• La légende : 

– Précision : précision des valeurs hautes et basses des textes 
d’étiquettes
• Un nombre positif représente les décimales
• Un nombre négatif arrondit aux puissances de dix

– Couper : suppression des « zéros » inutiles

Formation QGIS – © JM Michalowski  - IFAPME 2026 56



Polygones : rendu gradué
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Légende : 
• Précision 1 décimale
• Couper les zéros
Classer ensuite



Polygones : rendu gradué

Formation QGIS – © JM Michalowski  - IFAPME 2026 58



Polygones : rendu gradué
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Polygones : rendu gradué
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Rendu Gradué par Jolies Ruptures



Polygones : rendu gradué
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Rendu Gradué par Nombre égal – 3 classes



EXERCICE 5

Polygones : 

• Enregistrer le style 
en base de données
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Enregistrer le style en Base de Données

1. Permet d’associer un style, à une couche stockée dans un 
fichier GPKG et de fournir un style par défaut
– Une table « layer_styles » est créée dans le GPKG

2. Usage limité à QGIS → pas compatible ArcGIS PRO 
– ArcGIS PRO lit les données géométriques et les attributs

– Aucun format d’échange de symbologie entre QGIS et ArcGIS

– Format SLD ?

3. Légende ArcGIS .Lyr → QGIS 
– installer l’extension QGIS « SLYR »

– https://north-road.com/slyr/ 
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https://north-road.com/slyr/
https://north-road.com/slyr/
https://north-road.com/slyr/
https://north-road.com/slyr/


Enregistrer le style en Base de Données

Couche « Corine Land Cover 2018 »

• Propriétés > Symbologie > [Style] > Enregistrer par défaut
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Enregistrer le style en Base de Données

• 2 options : 

– Base de données locale : Dans votre profil QGIS personnel

• Non portable et non échangeable : non recommandé

– Base de données source : Dans la table layer_styles de VOTRE 
fichier GeoPackage (ou de votre base PostGIS)

•  Portable : le style voyage avec le fichier .gpkg

•  Partageable : si vous envoyez le GPKG à un collègue, il aura le style

•  Multi-projets : fonctionne dans tous les projets QGIS

•  Multi-utilisateurs : tout le monde voit le même style par défaut
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Enregistrer le style en Base de Données
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EXERCICE 6

Représentation lignes : 

• Symbole 
multicouches
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Représentation de lignes
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Groupe « Mobilité » - Couche « RAVEL »

• Symbologie > Rendu Catégorisé > Valeur : REVETEMENT



Représentation de lignes
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Représentation de lignes
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Représentation de lignes
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Représentation de lignes
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EXERCICE 7

Représentation par 
Ensemble de règles

Représentation par 
Entités fusionnées 
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Représentation par ensemble de règles
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Groupe « Mobilité » - Couche « Voirie Liège »

Afficher les signets spatiaux [Ctrl+-Maj+B]



Représentation par ensemble de règles
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Groupe « Mobilité » - Couche « Voirie Liège »

Couche > propriétés > Symbologie

Style > Charger le style …



Représentation par ensemble de règles
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..\Cartographie\Symbologie\Styles\OSM Roads FR.qml

[Ouvrir] puis [Charger]



Représentation par ensemble de règles
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Représentation par ensemble de règles
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Représentation par ensemble de règles
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Représentation par ensemble de règles
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Représentation par ensemble de règles
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Représentation par Entités fusionnées
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• Permet de simuler une fusion des différents objets d’une couche, pour un rendu 
plus esthétique.

• Ainsi la fusion peut regrouper visuellement tous les objets grâce un même 
symbole.

• Elle peut aussi assembler les objets avec des caractéristiques semblables (via une 
catégorisation/graduation).

1. Ces fusions sont un artifice visuel, les objets restent indépendants les uns des autres.
2. S’il y a beaucoup d’entités, cette opération réalisée en temps réel peut être longue.



Représentation par Entités fusionnées
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Représentation par Entités fusionnées
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Sans fusion Avec fusion



Symbologie OSM

https://github.com/openstreetmap/map-
icons/tree/master 

https://wiki.openstreetmap.org/wiki/FR:%C3%
89l%C3%A9ments_cartographiques 

https://github.com/gravitystorm/openstreetma
p-carto/tree/master/symbols 
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https://github.com/openstreetmap/map-icons/tree/master
https://github.com/openstreetmap/map-icons/tree/master
https://github.com/openstreetmap/map-icons/tree/master
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EXERCICE 8
Configurer des 
symboles ponctuels 
avec des fichiers SVG
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Symbole SVG

Couche « Arrêts TEC Liège » > Propriétés > Symbologie 
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Symbole SVG
> Navigateurs SVG : choix du symbole
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Symbole SVG
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Couche Arrêts TEC >
Echelle et visibilité de la couche
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EXERCICE 9 Représentation par 
Polygones inversés
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Polygone inversé

L'affichage par polygone inversé dans QGIS est une technique 
de symbologie qui permet de dessiner le polygone en inversant 
son apparence.

Cela signifie que le style ou l'effet appliqué est affiché à 
l'extérieur du polygone, plutôt qu'à l'intérieur. Cela peut être 
utile pour créer des effets visuels intéressants, comme des 
ombres portées ou des masques.
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Bien gérer l’ordre des couches pour que le masque soit efficace



Polygone inversé
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Polygone inversé

Couche « Limites communales »

1. Couche > Propriétés > Symbologie > Polygones inversés
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Polygone inversé
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Définir la règle → critère d’exclusion



Polygone inversé
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Définir la symbologie du polygone masquant

Adapter l’ordre des couches : la couche 
masquante se place tout au-dessus 



Polygone inversé
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Rendre la couche « privée » [propriétés projet]



Polygone inversé
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Résultat final



EXERCICE 10 Représentation des 
courbes de niveau
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Courbes de niveau

Couche « Courbes niveau 10m province Liege » (source : ODWB)

• Echelle de visibilité de la couche : activée

Propriétés de la couche

• Symbologie : symbole unique – ligne simple avec tirets

• Etiquettes : 
– Etiquette simple sur le champ « elevation » (altitude)

– Texte : Arial Gras – 8 Pixels

– Formatage :  Activer le crénage (moins de pixellisation des textes)

– Arrière plan :  Afficher un plan – Forme : rectangle – Couleur : orange

– Position : Mode : Incurvé (Parallèle ? ) – Position :  sur la ligne

– Rendu :  Visible en fonction de l’échelle : 20.000e → 500e 
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Courbes de niveau
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Courbes de niveau

Couche « Courbes niveau 10m province Liege » (ODWB)

• Etiquettes : Autres options « Position »

▪ Répétition des étiquettes
le long de la ligne

▪ Nombreuses combinaisons
à tester

▪ Gestion des « collisions »
avec d’autres couches 
d’étiquettes

▪ Complexe !
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Lier un 
tableur Excel

• Installer l’extension

• Recommandations

• Joindre un tableur

– Tableur « SIG »

– Tableur « Data »

• Interroger
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Extension

Installer l’extension « Spreadsheet Layers»

• menu > Extensions > Installer/Gérer les extensions

• Dans la barre d’outils « Gestion des couches », 
ajout d’une nouvelle icone 
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Recommandations

STATBEL 

• Statistiques belges → Tableau de statistiques belges

• Informations par communes via le code communal INS

• Couche des communes : AdMuKey == code INS communal

• Insertion du tableau dans la BD
– Nettoyer le fichier pour ne conserver qu’un tableau avec entêtes

– Lien via extension « Ajouter Feuille de calcul … »

– Export du tableur lié vers le GPKG de la base de données

– Suppression du lien vers le tableur Excel
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Recommandations
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Données brutes / initiales



Recommandations
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Données traitées / OK QGIS



Lier un tableur
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• Fermer (en sauvant) le projet en cours

• Ouvrir le projet « Territoires » sous ../Jour3/Data

• Sous ../Jour3/Data, 2 fichiers EXCEL (source : Statbel)

– OPENDATA_Hainaut_MAP_2017-2024.xlsx
• Accidents de la route entre 2017 et 2024, Hainaut

• Uniquement les données géoréférencées → points

– Population_par_commune.xlsx
• Données population pour la BE

• Données attributaires uniquement → à lier aux communes



Lier un tableur « SIG »
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Lier le fichier des accidents
de  la route
• Cocher « Détecter fin »
• Cocher « Géométrie »
• Définir champs X & Y
• SCR : Lambert 72

Adapter le type de champ
(String, Real, Integer, Date)
si nécessaire.



Lier un tableur « Data »
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Lier le fichier « Population »
• Ignorer la 1ere ligne
• Cocher « Entête »
• Cocher « Détection fin … »

Adapter le type de champ
(String, Real, Integer, Date)
si nécessaire.

Définir à Integer



Accéder aux tableurs
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EXERCICE 11 Représentation par 
Groupement de points
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Groupement / Grappe de points
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Lorsque vous devez localiser un grand 
volume de points sur une carte, 
le cluster devient indispensable pour  
garantir une bonne lecture de vos 
informations.

Plus vous zoomez, plus celles-ci seront 
détaillées. De plus, les clusters permettent 
de dégager rapidement des grandes 
tendances, puisque leur taille peut varier 
selon les données



Groupement / Grappe de points
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• Couche « Territoire / OPENDATA_Hainaut_ …»
• Propriétés > Symbologie > rendu : Groupe de points                                      

Tester différentes distances



Groupement / Grappe de points
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Cluster – distance 10

Cluster – distance 5



Attributs et 
Formulaires

• Codes INS Belgique

• Modes d’affichage

• Accès aux attributs : 
identifier ou sélectionner

• Identifier par clic

• Sélectionner
– Dans zone

– Par requête
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Codes INS Belge
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Le code INS est un code numérique, élaboré par Statbel, l’office belge 
de Statistique, attribué à chaque entité administrative afin de faciliter 
le référencement géographique des statistiques produites.

Structure

– Level 1 [champ AdReKey] : 3 régions (RW = 03000)

– Level 2 [champ AdPrKey] : 10 provinces

– Level 3 [champ AdDiKey] : 43 arrondissements administratifs

– Level 4 [champ AdMuKey] : 565 communes (municipality)

– NameFRE : Nom en français 

Et beaucoup d’autres champs techniques / administratifs !

https://statbel.fgov.be/fr/propos-de-statbel/methodologie/classifications/geographie
https://statbel.fgov.be/fr/propos-de-statbel/methodologie/classifications/geographie


Les données attributaires
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Les options d’affichage des tables d’attributs

• menu Préférences > Options > Sources de données

• menu Projet > Propriétés > Sources de données

Rappel

« 0 » (zéro) n’est pas une valeur NULL



Les données attributaires

118Formation QGIS – © JM Michalowski  - IFAPME 2026 118

Identifiable : les couches qui répondront à l’outil « Identifier les entités » 

Recherchable : les couches qui répondront à l’outil « Locator » 

Requis : les couches qui doivent faire partir du projet

Lecture seule : les couches qui ne pourront pas être modifiées

Privée : les couches « fond de plan » qui ne seront pas affichées dans l’explorateur

Rappel



EXERCICE 12
Vérifier les options de 

configuration des
Préférences QGIS
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Options des Préférences
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Les données attributaires
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Adapter les options d’affichage des tables d’attributs



Identifier les entités
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Paramètres de comportement de l’identification

menu >Préférences > Options > Outils cartographiques

• Rayon de recherche pour identifier les entités et afficher les 
infobulles est la distance à l’intérieur de laquelle l’outil 
d’identification affichera les résultats.

• Couleur de la sélection vous permet de choisir avec quelle couleur 
les entités qui sont sélectionnées sont mises en surbrillance.

• Tampon détermine une zone tampon pour la mise en surbrillance 
des bordures des entités identifiées .

• Largeur minimum détermine l’épaisseur de la bordure d’un objet 
mis en surbrillance.



Identifier les entités
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Tampon : 0 mm
Largeur min : 1 mm

1,0 mm



Identifier les entités
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QGIS propose plusieurs façons d’identifier les entités avec l’outil         

Identifier les entités. 



La barre des Attributs
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Identifier les entités (objets géométriques)

Calculatrice de champs → mises à jour attributs

Boîte de traitements → bibliothèque de scripts

Résumé statistique

Ouvrir la table d’attributs (de la couche courante)

Mesurer (distances, superficies, angles)

Activer info-bulle (au passage de la souris)

Actions (attribut utilisé comme paramètre)



Accéder aux attributs des 
objets

Méthode 1 : Identifier les attributs

Formation QGIS – © JM Michalowski  - IFAPME 2026 126



Les données attributaires
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Projet ../Jour3/Data/Territoire.qgz



Identifier les entités
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Viser une communeClic GAUCHE



Identifier les entités
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Visée dans la carteClic DROIT



Identifier les entités
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En mode tableau, les options suivantes sont disponibles pour 
simplifier l’affichage et forcer le mode formulaire si une seule 
entité est identifiée.



Identifier les entités
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Autres options pour
Identifier les entités
(usage minoritaire)



Identifier les entités
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Données Dérivées

Action → Formulaire

Données attributaires



Accéder aux attributs des 
objets

Méthode 2 : Ouvrir la table des 
attributs
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Ouvrir la table des attributs
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4 fonctionnalités principales :

Afficher toutes les entités

Afficher les entités sélectionnées

Afficher les entités visibles sur la carte

Afficher les entités modifiées et nouvelles



Ouvrir la table des attributs
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Barre édition Barre Filtre / sélection [1] [2]   [3]    [4]  [5]

[1] : organiser mode Tableau 
[2] : mise à jour
[3] : organiser mode Tableau 
[4] : Actions
[5] : mode intégré
[6] : Tableau  Formulaire
[7] : Filtres sur les entités

[6][7]



Les données attributaires
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Mode formulaire intégré

Mode Formulaire

Mode formulaire flottant / intégré



Les données attributaires
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Tri possible

Mode Tabulaire  Tableau

Mode tableau intégré
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Affichage des clés en mode Formulaire

Les données attributaires
Nom de 

l’attribut utilisé 
comme clé

Sauver le projet pour
conserver ce paramètre



Accéder aux attributs des 
objets

Méthode 3 : Infobulles et Etiquettes
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Les données attributaires : étiquettes

Formation QGIS – © JM Michalowski  - IFAPME 2026 140

• Propriété « Couche » > Etiquette > « nom d’un attribut »

Texte affiché sur l’objet



Les données attributaires : Infobulles
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• Propriété « Couche » > Info-bulle > « nom d’un attribut »

Au survol par la souris de l’objet DE LA COUCHE ACTIVE



Les données attributaires : Infobulles
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Configuration : préférences et options « infobulles »
• Propriété « Couche » > Info-bulle > attribut + code HTML ( IA)

Formation avancée



Les données attributaires : Infobulles
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Configuration : préférences et options « infobulles »

• Propriété « Couche » > Info-bulle > attribut + code HTML

Formation avancée



Les données attributaires : Infobulles
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Les données attributaires
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Etiquette

Infobulle

Infobulle <> Etiquette



EXERCICE 13

Modifier l’infobulle de la 
couche des Communes

1. Sans code HTML

2. Avec code HTML
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Les données attributaires : Infobulles
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Couche Limites Communales :

1. Ajouter une infobulle qui affiche le nom de la 
commune et son code INS entre parenthèses

2. Ajouter une infobulle avec du code HTML
Utiliser le fichier ../Jour3/data/Infobulle_Communes_HTML.txt

Editeur code HTML basique (2007), suffisant pour enrichir QGIS
https://nvu.fr.softonic.com/ 

https://nvu.fr.softonic.com/


Les données attributaires : Infobulles
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Commune de [%"NameFRE"%] ([%"AdMuKey"%])



Les données attributaires : Infobulles
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La sélection des objets
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Les modes de Sélection
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Ouvrir la table d’attributs

• Affiche dans une fenêtre indépendante, sous forme d’un 
tableau, les attributs de la couche active.
– Si certaines entités de cette couche sont dans le panier de la 

sélection, ils sont mis en évidence dans le tableau.

– Plusieurs tables d’attributs peuvent être ouvertes 
simultanément. 

• Vous pouvez ouvrir la table d'attributs en cliquant avec le 
bouton droit sur la couche dans le panneau des couches et 
en sélectionnant "Ouvrir la table d'attributs", ou en 
utilisant le bouton spécifique dans la barre d'outils.



La barre de Sélection
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Sélection graphique des entités par « clic » ou rectangle 

Sélection graphique des entités avec un polygone

Sélection graphique des entités à main levée

Sélection graphique des entités selon un rayon

Sélection des entités par valeur

Sélection des entités à l’aide d’une expression

Sélection de toutes les entités

Inverser la sélection

Désélection de toutes les entités sélectionnées

Désélection des entités sélectionnées dans la couche courante
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Sélection d’entités
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Sélection par un rectangle



Sélection d’entités
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Afficher les entités sélectionnées

Ne montrer que les entités sélectionnées



Sélection d’entités
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Barre de navigation dans la sélection
Mise en surveillance entité courante
Zoom sur entité courante 



Sélection d’entités
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Gestion de la sélection courante

• Propriété Couche > Zoom sur la sélection

• Ajouter entité à la sélection : <CTRL>+viser nouvelle entité

• Retirer entité de la sélection : <CTRL>+viser entité 
sélectionnée

• Désélection des entités sélectionnées dans la couche 
courante



Filtre d’entités
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Filtrer avec un / plusieurs critères (non-sélection)



Filtre d’entités
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Filtrer avec un / plusieurs critères (non-sélection)



Lier un tableur « Data » à 
la couche « Communes »

Enrichir les données communales
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Extension

Installer l’extension « Spreadsheet Layers»

• menu > Extensions > Installer/Gérer les extensions

• Dans la barre d’outils « Gestion des couches », 
ajout d’une nouvelle icone 
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Lier un tableur

STATBEL 

• Statistiques belges → Tableau de statistiques agricoles 2023

• Informations par communes via le code communal INS

• Couche des communes : AdMuKey == code INS communal

• Insertion du tableau dans la BD
– Nettoyer le fichier pour ne conserver qu’un tableau avec entêtes

– Lien via extension « Ajouter Feuille de calcul … »

– Export du tableur lié vers le GPKG de la base de données

– Suppression du lien vers le tableur Excel
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Lier un tableur
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Données brutes / initiales



Lier un tableur
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Données traitées / OK QGIS



Lier un tableur « Data »
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1. Le tableur lié doit il être mis à jour régulièrement ?

• Oui → garder fichier Excel & option de mise à jour de la liaison
• Non → sauver le tableur dans le GPKG contenant la couche SIG 

auquel il est lié ou dans un GPKG dédicacé aux datas 

2. Le tableur lié ne doit pas être mis à jour régulièrement

• Exporter > Sauver les entités sous … fichier GPKG
• Le fichier sauvé dans le GPKG sera le tableur lié. 
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Format : GPKG
Nom du fichier : <DataExternes.gpkg>
Nom couche : 
population_par_commune_2025

SCR : pas de SCR car données non SIG

Géométrie : Pas de géométrie

 Ajouter les fichiers …  
[OK]                  

> Exporter > Sauver les entités sous …

Couche « Population_commune_2025 »



Lier un tableur « Data »
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> Propriétés > Jointure > 

Options pour fichier dynamique

Jointure des champs utiles

Préfixe pour sourcer data



Lier un tableur « Data »
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